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1. Introduction      

This document describes how to setup and configure WiPOM Client Software and BiPOM Web Portal. 

WiPOM Client allows monitoring and logging different physical and environmental values like voltages, 

currents, temperature, humidity, and many others remotely.  

WiPOM Client uses either BiPOM’s nanoWipom or CloudGate nanoWipom (CG9101-nanoWipom) 

board as the hardware platform. nanoWipomM7 is a miniature wireless remote monitoring computer 

based a STM32 Cortex™-M7 processor. CG9101-nanoWipomM3 is the same as regular 

nanoWipomM7 except that it is designed as a plug-in peripheral card for the CloudGate cellular gateway. 

The software includes a Windows WiPOM Client for configuring the system and read the logged data 

and the BiPOM Web Portal that allows remote access to nanoWipomM7 boards for configuring the 

system and accessing the logged data.  

Windows WiPOM Client features: 

• Connect to the device over RS232 serial port, RS485 serial port, or USB 

• Read current device configuration, including tags configuration 

• Configure device name, date/time, hardware calibration, RS485 port settings 

• Check hardware status and health information 

• Add/edit/delete tags 

• Configure alarm conditions individually for each tag, including SMS and email capability 

• Manage contact list for SMS and email support 

• Configure conversion parameters for tag value 

• Start / stop logger 

• Upgrade firmware 

• Read collected data, events, and alarms   

• Export collected data, events, and alarms to Excel compatible format 

 

Web Portal features: 

• Add/edit/delete WiPOM/nanoWipomM7 devices into customer account 

• Communicate with device remotely through GSM modem (GPRS) 

• Read current device configuration, including tags configuration 

• Configure device name, date/time, hardware calibration, RS485 port settings 

• Add/edit/delete tags 

• Configure alarms conditions individually for each tag 

• Configure conversion parameters for tag value 

• Start / stop logger 

• Upgrade firmware 

• Read collected data from device to server database periodically (the period is configurable by 

user) 

• Export collected data, events, and alarms to Excel compatible format 

• Read tag’s state in real/time 

• Draw charts for selected tags 
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2. Hardware Setup 

2.1 Using nanoWipomM7 

Before powering, set the jumpers on the nanoWipomM7 as needed for your application. Refer to 

nanoWipomM7 User Manual for the details of jumper settings. 

The simplest way to power nanoWipomM7 and communicate with the Windows PC is the mini USB 

cable. 

 

 

Figure 1 – Power nanoWipomM7 with USB connection 
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Insert the (optional) MicroSD card and connect the mini USB cable to the USB Device connector: 

 

 
 

Figure 2 – Inserting MicroSD card 
 
 
The LEDs should both turn on and then the bi-color LED should remain solid green while the other LED 

will blink orange. Solid green means the power level is good and nanoWipomM7 is ready for use. 

 

Orange LED shows communications. Blinking Orange LED indicates that nanoWipomM7 is trying to 

establish +communications. Solid Orange LED indicates that the communications are established.  

 

If the bi-color LED turns red, this shows a fault. If the bi-color LED turns solid red or blinks red, contact 

BiPOM Electronics for technical support. 
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2.2 Using CloudGate nanoWipom ( Part#: CG9101-nanoWipom) 
 
Set the jumpers on the CG9101-nanoWipom as needed for your application. Refer to CG9101-

nanoWipom User Manual for the details of jumper settings. 

 

Insert the (optional) MicroSD card on the CG9101-nanoWipom: 

 

 
 

Figure 3 – Inserting MicroSD card 

 
Insert the CG9101-nanoWipom into CloudGate front peripheral slot as shown: 
 

  
 

 

Figure 4 – Inserting CG9101-nanoWipom into CloudGate 

 
Power CloudGate through the power connector using the CloudGate Adapter or any other power source 

that is capable of powering CloudGate. 

 

The LEDs should both turn on and the Green LED should remain solid while the other LED will blink 

orange. 

When power is applied Green LED turns ON. Green LED shows power status. Solid green means the 

power level is good and CG9101-nanoWipom is ready for use. 

Orange LED shows communications. Blinking Orange LED indicates that CG9101-nanoWipom is trying 

to establish +communications. Solid Orange LED indicates that the communications are established.  

Red LED shows a fault. If the Red LED turns on or blinks, contact BiPOM Electronics for technical 

support. 
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3. Software Setup 

 
Download and run the latest WiPOM Client software setup from the BiPOM web site: 
 
http://www.bipom.com/files/wipom/WRTUClientSetup.exe 
 
 

 

Figure 5 - WiPOM Client software setup window 
 
Click Next on the Welcome window. 
 

 

Figure 6 – Choosing to install location 
 
  

http://www.bipom.com/files/wipom/WRTUClientSetup.exe
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Either use default install location or choose a different location and click Next.  
 

 

Figure 7 – Choosing start menu folder 
 
Use the default Start Menu Folder name and click Install. 
 

 

Figure 8 – WiPOM Client setup completing window. 
 
After all, files are installed, the last window of installation has the option to start WiPOM Client after 

installation is completed. Click Finish to complete installation. The WiPOM Client will be installed on 

your PC. 
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4. Windows WiPOM Client        

  
4.1 Run WiPOM Client  
 
On Windows 8.1 and 10, open the Start Menu and click the WiPOM Client icon.  

After the WiPOM client starts, then the following screen will appear: 

 

 
 
 

Figure 9 – The main window of the WiPOM Client in OFFLINE state 
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To run WiPOM Client, the following steps can apply; 
 

1. Powerboard 

2. Connect the USB cable from the board to the PC. 

3. Click the Connect button on the WiPOM client System tab. 

 
Figure 10 – Connect button in the main screen 

 
Select COM port for USB. nanoWipomM7 USB port appears as a serial (COM) port to Windows. It is 

typically a higher port number such as COM3.  

 

 
Figure 11 – Selecting COM port window 

 
Click Next. 
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Figure 12 – Set synchronization options 

 
Click Start. 
 
 

 
 

Figure 13 – Synchronization progress window 
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When software reads all information from the board it will show the status of the device on the main 

window. 

 

 
 

Figure 14 – WiPOM Client in ONLINE state 
 

  



 

11 
 

4.2 File Menu 
 
When the WiPOM Client starts, it creates a new project with default values. You can edit and change 

the project configuration even when the nanoWipomM7 board is not connected to the PC. Any changes 

can be saved to the Project file. Also, you can load the previously saved project file into WiPOM Client. 

 

The File menu has all the operations related to project management: 

 

New Project  – The device is determined for the new project 

Load Project – Opens a dialog to select previously saved project file and load it into the 

WiPOM Client 

Save Project  – Saves changes to the project 

Save Project As  – Allows saving the project using a different file name 

Recent Project  – Opens the last worked projects 

Reset Project  – Resets the configuration to its default values 

Exit   – Close the WiPOM Client 

 

 
 

Figure 15 – File menu 
 
 
Note that the project file does NOT contain and save the following values: 

 

- Status of the logger, modem, peripherals, date/time, firmware version. These values available 

only when the nanoWipomM7 board is connected to PC and the WiPOM Client is in Online 

mode. 

 

- All values from the Peripherals tab. These values are hardware-related and available only in 

Online mode. 

 

- Logged data is also not saved. 
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To save a project: 

 

- Run WiPOM Client 

- Make the required changes to the configuration 

- Go to the File menu and click Save Project 

- Select the file in opened dialog or enter a new name and click OK 

 

To load a project: 

 

- Run WiPOM Client 

- Go to the File menu and click Load Project 

- Select the file in opened dialog and click OK  

 

To set default values to the project: 

 

- Go to the File menu and click Reset Project 

 

 
 

 

  

IMPORTANT: All changes made in the current project will be applied to the board only during 

connection to the board or when synchronization is started manually using the Synchronize button 

on System tab. 
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4.3 Tools Menu 

Tools menu has 3 sub-setting menus; 

 

Figure 16 – Tools menu 

4.3.1 Options 
To change WiPOM Client options do the following steps: 

 

- Run WiPOM Client 

- Go to main menu Tools and click Options … 

 

 
 

Figure 17 – WiPOM Client Options – General tab 
 

There are 3 tabs and their subsections.  
 

4.3.1.1 General 
 
2 options can be enabled or disabled: 
 
Check for software update on start: 
 
If this option is enabled, then WiPOM Client checks for available updates on BiPOM website every time 

the WiPOM Client is started. 

 
Check for firmware update on Connect: 
 
If this option is enabled, then the WiPOM Client checks if the firmware on the connected nanoWipomM7 

board is older than the firmware available in WiPOM Client setup. If the board has old firmware, WiPOM 

Client will prompt to upgrade the firmware to the latest one.  
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4.3.1.2 Communications 

 
There are 4 configuration setups. 

 

Figure 18 – WiPOM Client Options – Communications Tab 

TCP session limit 

A single listening port can accept more than one connection simultaneously. 

 

TCP Connect Timeout 

TCP specification [RFC0793] defines a local, per-connection "user timeout" parameter that specifies the 

maximum amount of time that transmitted data may remain unacknowledged before TCP will forcefully 

close the corresponding connection. 

 

TCP Read Timeout 

TCP read timeout; a client hasn’t received data from the server after [READ_TIMEOUT] time. 

 

Serial Read Timeout 

Gets or sets the number of milliseconds before a time-out occurs when a read operation. 

Send the message to the device; Read from the serial port until a response had been received or a 

timeout occurred. 
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4.3.1.3 Tag View 

 
12 options can be enabled or disabled; 

Name, scan, RTU, address, type, log period(sec.), alarms, holding register, real-time value, holding 

register value, units, raw value. 

 

Figure 19 – WiPOM Client Options – Tag View Tab 
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4.3.2 Change Admin Password 

Users can change the Admin Password. 

 

Figure 20 – Change password window 

 

 

4.3.3 Switch to ADMIN Mode 

Users can switch to Admin mode. 

 

Figure 21 – The password window for Switch the Admin Mode 
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4.4 Help Menu 

There are 2 sections in the Help menu. 

 
4.4.1 About WiPOM Client 

 
To get information about WiPOM Client installed on your PC: 
 

- Run WiPOM Client 
- Go to main menu Help and click About … 

 

 
 

Figure 22 – WiPOM Client About Dialog 
 
 
The main information is Version and Release Date. This information is helpful for troubleshooting and 

technical support. 
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4.4.2 Checking for software updates 

 
By default, WiPOM Client software checks for new updates on every start. This option can be disabled 

to check for new updates manually. To check for new updates: 

 

- Start WiPOM Client 

- Select the Help menu and select Check New Version 

 

WiPOM Client then accesses BiPOM web site (www.bipom.com) and checks if a new version of 

WiPOM Client is available. If there is no new version on the web, the following window is shown: 

 

 
 

Figure 23 – Window when no software updates available 
 

 

If a new version of the WiPOM Client exists on BiPOM web, the following window is shown: 

 

 

Figure 24 – Window when software updates are available. 
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If a new version is found, click Yes, and the WiPOM Client downloads and installs the new version in 

the background. 

 

When the download completes, the following window is shown: 

 

 

 

 

Figure 25 – Warning window when starting the software update. 

 

If you click Yes, then the current the WiPOM Client software is closed, and all project changes will be 

saved automatically. If changes are done in the new project, then the software will prompt to select the 

file where save changes. After this system will start to update the installer. 

 

If you click No, then the window is closed, and no further action is taken. 
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4.5 Toolbar Icons 

WiPOM Client has many shortcut icons. In this way, the user can give many commands without entering 

the menus. 

 

 
  a   b    c    d    e     f      g    h     i    j     k      l     m    n    o    p    q     r     s    t      u    v    w    x     y     z 

 

a. New Project 

The device is determined for the new project. 

                       
Figure 26 – New Project window 

 

b. Open Project 
Opens dialog to select previously saved project file and load it into WiPOM Client. 
 

c. Save Project 
Saves changes to the project. All changes in device configuration can be saved as a WiPOM 
Project File (.wproj). This helps create a configuration once and use it for several devices. 
 

d. Save Project As 
Allows saving the project using a different file name. 
 

e. Open Option Window 
See section 4.3.1 Options topic for more information about tag window controls. 
 

f. Switch to ADMIN Mode 
Users can switch to Admin mode. 
 

g. Connect/Disconnect 
Connect or disconnect to the device. 
 

h. Synchronize 
Write current configuration loaded in the client to the connected device. 
 

i. Start/Stop Logger 
Start Data Logger on the connected device. This means that the device will watch inputs, log data 
and generate alarms. Stop Data Logger on the connected device. This means that the device will 
not watch inputs, so no logged data and no alarms will be generated. 
 

j. Sync Time 

Set current PC time to RTC on the device. 
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k. Restart Firmware 
Send command to the device to restart firmware. WRTU Client will be switched to offline mode 
automatically. 
 

l. Upgrade Firmware 
Start firmware upgrading. 
 

m. Read Logged Data 
Read all logged records from the device. 
 

n. Erase Logged Data 
Erase all logged data on the device. 
 

o. Export Data 
Export read records to Excel or CSV (comma-separated value) file. 
 

p. Import Contacts 
Imports contacts from an Excel file. 
 

q. Add Contact 
Adds a new contact. 
 

r. Edit Contact 
Edits the selected contact. 
 

s. Delete Contact 
Deletes the selected contacts from the project. 
 

t. Delete All Contacts 
Deletes all contacts from the project 
 

u. Add Tag 
This button opens Adding New Tags where a new tag can be created and configured. 
 

v. Edit Tag 
This button opens Editing Tags where existing tags can be configured. 
 

w. Delete Tag 
This button deletes all the selected tags from the project. 
 

x. Delete All Tags 
This button deletes all the tags from the project. 
 

y. Apply Changes 
Apply all changes of WiPOM Client. 
 

z. Open Help 
 To get help about WiPOM Client online: 
 

- Run WiPOM Client 
- Go to the Help menu and click Online Help 

 
This will open online help in the default Internet browser. 
 
Online help available at the web address: 
 
http://help.bipom.com/index/4379895.html 
 

 

http://help.bipom.com/index/4379895.html
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4.6 System Information 

System information is displayed on the System tab. The available actions and presented information 
depended on the current mode of the WiPOM Client. The System tab in Offline Mode is shown in 
Figure 15. 
 

 
 

Figure 27 – System tab (Offline Mode) 

 
In Offline Mode the only available actions are Connect and Upgrade Firmware ….  
 
Connect 
When you click Connect button you run Connection Wizard which helps connect to the board and 
switch the client to Online Mode. 
 
Also, device information is not available in Offline Mode. It will be updated only when WiPOM Client 
will be switched to Online Mode. 
 
Upgrade Firmware … 
When you click Upgrade Firmware … button you can select the WiPOM firmware HEX file and upload 
it to the device. 
This will work even when WiPOM Client is not connected to the device. 
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The System tab in Online Mode is shown in Figure 27: 
 

 
 

Figure 28 – System tab (Online Mode) 

 
When WiPOM Client changes to Online Mode, the following information is updated: 

State 

The current state of the WiPOM Client: it can be ONLINE or OFFLINE. 

 

ONLINE  – the client is connected to the device 

OFFLINE  – the client is not connected to the device 

 

Hardware Type 

The board name in hardware setup. Depending on the board, WiPOM client may have different 

features and capabilities.  

Possible values: UNKNOWN, WiPOM, nanoWipomM7, CG9101-nanoWiPOM 

UNKNOWN  - hardware type is no. Is shown when client not connected to hardware 

WiPOM   - hardware has installed WiPOM board 

nanoWipomM7  - hardware has installed nanoWipomM7 board  

CG9101-nanoWiPOM - Cloudgate version of nanoWiPOM 

 

 

 
 

More information about WiPOM board: http://www.bipom.com/products/us/4379874.html 

More information about nanoWiPOM board: http://www.bipom.com/products/us/4357735.html 

 

More information about CG9101-nanoWiPOM board: 

http://www.bipom.com/products/us/4380902.html 

http://www.bipom.com/products/us/4379874.html
http://www.bipom.com/products/us/4357735.html
http://www.bipom.com/products/us/4380902.html
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Firmware Version 
The version of the firmware running on the device. 

 
Firmware Status 
Each WiPOM Client release also includes the latest firmware binary file. When the Client connects to 
the device, it checks if the current firmware is an older version.  
 
If so, the Client shows a prompt to upgrade the firmware to the latest version. Possible messages: 
 
Upgrade not required - This means that the device has the latest firmware. The upgrade button will be 
disabled.  
 
New version is available - This means that the client has a more recent version of the firmware than 
the one on the device. The upgrade button will be enabled. 
 
 

 
 
 
  

NOTE: It is recommended to upgrade to the latest firmware when it is available. WiPOM Client may 

have features available only for the latest firmware. Also, the latest firmware may include bug fixes 

and other improvements. 
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DAQ2543 
This status field shows information about the DAQ2543 peripheral board. If firmware detected this board, 
then the text will be DETECTED. If the firmware didn’t detect this board, then the text will be NOT 
DETECTED/FAILED.  
 
Cell Modem 
This status field shows information about Cell Modem. If firmware detected the modem, then the text 
will be DETECTED. If the firmware didn’t detect the modem, then the text will be NOT 
DETECTED/FAILED.  
Also, it shows the type of detected modem: 

 
WMP50 2G 
HE910-D 3G 
Unknown (a modem was detected but it is an unsupported model) 

 
Date / Time 
This field shows the current date and time from the device and updates this information every second. 

 
Logger State 
This status field shows information about the data logger state. The data logger state can be in 2 modes: 
started and stopped. If the data logger is started, then the device shows the text STARTED. Also, when 
the data logger is stopped it shows the text STOPPED. 
 
When WiPOM Client in Online Mode it can do the following actions: 
 
Synchronize 
Write current configuration loaded in the client to the connected device. 
 
Disconnect 
Switch WiPOM Client to offline mode 
 
Start Logger 
Start Data Logger on the connected device. This means that the device will watch inputs, log data and 
generate alarms. 
 
Stop Logger 
Stop Data Logger on the connected device. This means that the device will not watch inputs, so no 
logged data and no alarms will be generated. 
 
Synchronize Time 
Set current PC time to RTC on the device. 
 
Restart Firmware 
Send command to the device to restart firmware. WiPOM Client will be switched to offline mode 
automatically. 
 
Upgrade Firmware 
Start firmware upgrading. 
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4.7 Communications Settings 

All communications options are grouped on the Communications tab: 
 

 
 

Figure 29 – Communications Settings 
 

Common 

On Enable RS485 Modbus Forwarding option can be enabled or disabled. 

• Modbus RTU Interpacket Delay 

• Modbus TCP Interpacket Delay 

• Register Per Packet 

• Modbus TCP Port 

 

Cell Settings 

Enable/disable cell communications. If this option is disabled, no SMS alarms or requests through GPRS 

will be processed. 

• APN server name. Used for initializing cell modem GPRS internet. This comes from the SIM 

card plan. 

• User Name/Password; These are usernames and passwords required by the APN server. If 

they are not required, leave these fields blank. 

• Modem Type (Cell Modem, Iridium Satellite Modem) 

SMS/Email Settings 

SMS/Email Retry Time Limit can be set as minute(s). 
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SMTP Settings 

The following information can be edited. After can use the Check STMP Settings button. 

• Server address 

• Port 

• Login/Password 

• From Email 

• Email Subject 

 

RS232 Port 

RS232 serial port communication options. This port is used for processing incoming MODBUS requests. 

• Baudrate (1200 – 115200) 

• Parity (None, Even, Odd) 

• Stop Bits  

• Data Bits  

 

RS485 Port Settings 

RS485 serial port communications options for communicating with other MODBUS devices. 

• Baudrate (1200 – 115200) 

• Parity (None, Even, Odd) 

• Stop Bits 

• Data Bits 

• Read Timeout 

 

Data Pushing Settings 

Enable/Disable data pushing. 

• Protocol 

• Port 

• Address 

• Period (1 Hour - 1 Day) 

• Offset 

• Format 

 

Account 

Login and Password can be entered in this section. 

 

 

 
 

IMPORTANT: RS485 and RS232 port settings are applied only after a firmware restart. 
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4.8 General Settings 
 
Name 
The device name. Any text up to 31 characters. 
 
RTU Number 
A number from 1 to 255; is used in MODBUS communication. Only requests with this RTU Number will 
be processed by the device. 
 
 

 
 

Figure 30 – General Settings 
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4.9 Peripherals 

ADC Calibration 

 
When tags with types of Voltage RMS are used, it is recommended to calibrate zero levels on AN2 and 

AN3 ADC inputs to minimize errors. These options are under the Peripherals tab. 

 
 

 
 

Figure 31 – Peripherals information 
 

The current calibration levels are shown in read-only text fields (if the calibration was done previously). 

To save the new zero level the WiPOM Client must be in Online mode. After this, apply zero level 

signals to ADC input, and when the signal is stabilized click Calibrate button. This will force hardware 

to read the current ADC input value and save it as Zero Level in the configuration on the device. 
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DAQ2543 Self-Test Values 

 
Each DAQ2543 peripheral board has 3 inputs for self-test. These inputs setup to always return bottom, 

middle and top values. These values are shown on the Peripherals tab. Please see Figure 8. 

 
If the DAQ2543 board is installed and accessible, then these values should be very close to the 

following: 

 

Point Value 

Bottom 0 

Middle 2047 

Top 4095 

 
Table 1 – Good DAQ2543 Self-Test Values 

 
If the DAQ2543 board is missing, then values will be: 

 
Point Value 

Bottom 4095 

Middle 4095 

Top 4095 

 
Table 2 – Bad DAQ2543 Self-Test Values 

 
If the DAQ2543 board has a hardware problem, then the values may range from 0 to 4095. 

 

LCD Options 

 
Screens Delay – this option controls how fast screens on LCD will be switched. LCD shows the 

information on several screens: 

 

Main screen – show general information about the device. 

Modem Status screen – shows information about modem current status. 

Tags data screen – shows information about current values of configured tags (if a lot of tags added 

system will have more than 1 tag’s screen) 

 

The screens Delay option allows you to change the delay between screens. Then larger delay – than 

longer each screen will be presented on LCD. 
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4.10 Tags 
 
WiPOM uses tags to monitor inputs, control outputs, and describe logging options and alarm settings 

for each input. Tags are entered by the user and they are typically assigned meaningful names when 

they are first created. The tags in the current configuration are displayed under the Tags tab: 

 

 
 

Figure 32 – Tags tab 
 

On this tab, user can add new tag(s), edit existing tag(s) duplicate tag(s), and remove tag(s). 
 

Add 

This button opens Adding New Tags where a new tag can be created and configured. 

 

Edit 

This button opens Editing Tags where existing tags can be configured. 

 

Duplicate 

This button duplicates the selected tags from the project. 

 

Delete 

This button deletes all the selected tags from the project. 

 

Delete All 

This button deletes all the tags from the project. 
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4.10.1 Adding New Tags 
 
When the user clicks the button Add then Adding New Tags is opened: 
 

 
 

Figure 33 – Add New Tag Window 
 
This window has 4 tabs: General, Values Map, Calculations & Scaling, Alarms. 
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4.10.2 Adding New Tags: General Settings 

 

 
 

Figure 34 – Adding New Tags: General Settings 
 

This tab provides general information about the tag: 

 

Name  

Descriptive name of the tag  

 

Type 

Type of data source for the tag 

 

Address 

MODBUS address of the tag. Depending on the selected Type, the list of available MODBUS registers 

will be updated. 

 

Units 

Units for the tag’s value when the value is shown somewhere (on the display, in Logged Data table in 

WiPOM Client or when exported to a file) 

 

Enable Logging 

Flag to enable/disable data logging for the tag. This is typically used when the tag is used only to 

generate an alarm(s) and there is no need to log the data for the tag. 
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Log Period 

Data logging period (in several seconds) for the tag. 

0 means log data as fast as possible. 

 

RS485 MODBUS Slave Parameters 

 

If the tag’s Type is selected as the RS485 MODBUS then RS485 MODBUS Slave Parameters list is 

shown to specify RS485 tag addressing. 

 

RS485 MODBUS is a special tag type that is used when the tag’s data is read from a slave MODBUS 

RS485 device using MODBUS RTU protocol. To communicate with a MODBUS device over RS485 

using MODBUS RTU, WiPOM has to know the RTU Number of the slave device and the MODBUS 

register address.  

 

RS485 MODBUS Slave Parameters provides a set of controls that allow configuring these parameters: 

 

RTU Number 

RTU Number of the slave device 

 

Register Type 

The type of target MODBUS register. This helps to accurately check if the registered address is entered 

correctly. 

 

MODBUS Register 

Address of target MODBUS register. WiPOM will check if the address is correct depending on the 

selected Register Type. 
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4.10.3 Adding New Tags: Values Map Settings 

 

 
 

Figure 35 – Adding New Tags: Values Map Settings 
 
This tab provides controls to configure Values-To-Text mapping for some types of tags. This is useful 
when a tag’s values are limited to a set of constants that can be mapped to text. After such mapping, 
the tag’s value can be displayed as text instead of a number. 
 
For example, register #40107 returns the reason for the latest board reset as an integer constant. Since 
this register returns a limited set of values (0 to 6), each value can be mapped to a corresponding text. 
 
Enable Values Map  
 
This flag enables/disables this feature. 
 
Only the following tag types support the values map feature: 
 

• Analog Input 

• Holding Register 

• DAQ2543 ADC 

• RS485 Modus (when Register Type set to Holding Register) 
 
Add 
 
Add button creates a new entry in the values map. Each entry contains 2 values: 
 
Value - A number (tag’s value) 
Text  - A string that will be shown instead of the number in the Value column. 
 
Delete 
Deletes the selected entry. 
 
Delete All 
Deletes all entries. 
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4.10.4 Adding New Tags: Calculations & Scaling 

 

 
 

Figure 36 – Adding New Tags: Calculations & Scaling Settings 

 
This tab provides controls to configure Calculations and Scaling rules on the tag’s value. 

 

WiPOM can convert the raw numeric value to a more meaningful value using predefined equations 

and/or scaling rules. 
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Calculations 

Raw tag data can be converted using one of the predefined equations. 

 

Type 

Supported equation types: 

 

No Calculations: Value is not converted. 

Linear:   Value is converted using the linear equation Y = A * X + B 

Quadratic:  Value is converted using the quadratic equation Y = A * (X ^ B) 

 

Where:  

 

X:  Tag’s raw value 

Y:  Tag’s converted value 

A and B: Constant coefficients, entered in Value A and Value B fields 

* : Multiplication operation 

^: Power operation 

 

 

For example, the tag for MODBUS register 30005 returns the on-board 5 Volt line voltage reading as 

the number of milliVolts. To convert the value to Volts, select Linear as the type of calculations: 

 

Then enter: 

 

Value A = 0.001 

Value B = 0 

 

As a result, if the tag has a raw value of 5000, the converted value will be 5.0 after the calculations. 
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Scaling 

Scaling allows scaling raw tag values according to calibrated values. 

 

Enable Scaling 

This flag enables or disables the scaling feature. 

 

Current Counts 

This field shows the current raw value for the selected tag. 

This value is updated every second when the WiPOM Client is in ONLINE state. 

This value is not updated when the WiPOM Client is in OFFLINE state. 

 

Zero Scale Counts 

Tag’s raw value for bottom/zero level 

To simplify the calibration, the WiPOM client has the Set button that copies the Current Counts value 

to this field. 

 

Full-Scale Counts 

Tag’s raw value for top/full level 

To simplify the calibration, the WiPOM client has the Set button that copies the Current Counts value 

to this field. 

 

Zero Scale Output 

Output value which maps to bottom/zero level. 

 

Full-Scale Output 

Output value which maps to top/full level. 

Software use 2 points linear scaling logic of value between zero and full points. 

This feature is useful when the displayed/logged value needs to be scaled to a meaningful physical 

value instead of the raw value. 

 

One possible application is converting pressure sensor raw value to PSI, Bars, or other values. 
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4.10.5 Adding New Tags: Alarm Settings  
 

 
 

Figure 37 – Adding New Tags: Alarm Settings 
 
This tab allows configuring alarm conditions for a tag. Each tag can have an alarm condition and WiPOM 

will check the tag’s value to see if it matches the configured alarm condition. When an alarm condition 

is detected, WiPOM sends the configured SMS message to the assigned Contact(s). 

 

Type 

 

Type of alarm  

System supports 2 types of alarm conditions: Limit and Value Changed 

 

Limit: Alarm is generated when the tag’s value crosses a preset level. 

Value Changed:  Alarm is generated when the tag’s value is changed. 

 

Timeout 

 

The alarm condition should be present during this Timeout period (number of seconds) before the 

system will generate an alarm. This prevents the system from generating false alarms when the value 

is quickly varying around the preset alarm level.  
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Deadband 
 
The tag’s value should cross the Deadband zone before the system will generate an alarm. This 
prevents the system from generating false alarms when the value is quickly varying around the preset 
alarm level. 
 
 
When the Limit type of alarm is selected, WiPOM can check several thresholds: Low Low, Low, Normal, 
High, and High High. Only the desired thresholds can be enabled using the checkboxes to the right side 
of each alarm level. 
 

 
 

Figure 38 – Adding New Tags: Enabling Alarm Levels 
 
WiPOM Client checks that all the alarm thresholds have correct values according to the rule: 
 

Low Low < Low < High < High High 
 
If Deadband is not zero, then Deadband is also used for checking the entered threshold values according 
to the rules: 
 

Low Low + Deadband < Low 
 

Low + Deadband < High  
 

High + Deadband < High High 
 
 
 
Alarm Condition  
 

This list is used for assigning SMS messages and Contact(s) to each alarm condition configured for 

the tag.  
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Assign SMS message 
 
To assign an SMS message to the alarm condition: 
 
 

• Select desired alarm condition in the list 

• Click the Set Message button 
 
This opens the Message window: 
 

 
 

Figure 39 – Adding New Tags – Message Window 
 

Using the Message window, enter the desired text that will be sent out when the alarm condition is 

detected. 

 

Note that the message can contain some embedded keywords for substitution: 

 

{DN} : Substituted with the device name 

{TN} : Substituted with the tag name 

{RV} : Substituted with the tag’s raw value 

{CV} : Substituted with the tag’s value after calculations or scaling 

{U} : Substituted with Units text. 

 

The buttons on the left side of the window allow quickly inserting these substitution keywords into the 

message text. 

 

When the message is composed click the Save button to save the message in the tag’s configuration 

or click Cancel to exit without saving. 
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Assign Contact(s) 

 
To assign Contact(s) to the alarm condition: 

 

• Select desired alarm condition in the list 

• Click the Set Message … button 

 

This opens the Alarm Contacts window: 

 

 
 

Figure 40 – Adding New Tags – Contacts Window 

 
This window has two lists: Available Contacts and Assigned Contacts 

 
Available Contacts  
 
The list of contacts that were added to the project and not assigned to this alarm condition. 
 
Assigned Contacts 
 
The list of contacts that were assigned to this alarm condition. 
 
 
There are 4 buttons in the middle: 
 
 
> : Moves the selected contact from Available Contacts to Assigned Contacts 
>> : Moves all contacts from Available Contacts to Assigned Contacts 
 
< : Moves the selected contact from Assigned Contacts to Available Contacts 
<< : Moves all contacts from Assigned Contacts to Available Contacts 
 
The assigned SMS message will be sent only to the contacts that are in the Assigned Contacts list. 
 
To save the selected contacts in the tag’s configuration, click the Save button. Click the Cancel button 
to exit without saving. 
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Note that when the alarm condition has an assigned SMS message, then the letter M is added to the 

list item. 

When alarm condition has an assigned Contact, then letter C is added to the list item: 

 

 
 

Figure 41 – Adding New Tags – Alarm Condition List 
 
In this screenshot, the tag has 3 alarm conditions: Low Low, Low and Normal. 

 

 

Low Low alarm condition has only an SMS Message assigned. 

Low alarm condition does not have either SMS message or Contact(s) assigned. 

Normal alarm condition has both an SMS message and Contact(s) assigned. 
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Note that if an alarm condition item has only an SMS message assigned or only a Contact assigned, 

WiPOM Client detects this as incorrect configuration and shows a warning: 

 
 

 
 

Figure 42 – Warning message when alarm condition configuration is not completed. 
 
When the tag’s configuration is completed, click the Save button to save the configuration in the current 

project. The correctly configured tag will be saved and added to the tags list. 

 

 
4.10.6 Editing Tags 
 
Tags can be edited using the Edit button.  

 

Editing Tags window is the same as Adding New Tags, but all fields are filled with tag’s configuration 

data when the window is opened. 

 
See section 4.10.1 Adding New Tags topic for more information about tag window controls. 
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4.11 Actions 
 
The WiPOM can have action entries that describe the people who will receive the alarms that are 

generated by the actions. The contacts included in the current configuration are displayed under the 

Actions tab: 

 

 
 

Figure 43 – Actions Tab 
 
On this tab user can add new action(s), edit existing action(s) duplicate action(s), and remove action(s). 
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Figure 44 – Add New Actions window 

 

 

Add 

This button opens Adding New Actions where a new action can be created and configured. 

 

Edit 

This button opens Editing Actions where existing actions can be configured. 

 

Duplicate 

This button duplicates the selected actions from the project. 

 

Delete 

This button deletes all the selected actions from the project. 

 

Delete All 

This button deletes all the actions from the project. 
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4.12 Contacts 
 
The WiPOM can have contact entries that describe the people who will receive the alarms that are 
generated by the tags. The contacts included in the current configuration are displayed under the 
Contacts tab: 
 

 
 

Figure 45 – Contacts Tab 
Add 
 
Adds a new contact 

 
Import 
 
Imports contacts from an Excel file 
 
Export 
 
Exports contacts to Excel file 
 
Edit 
 
Edits the selected contact 
 
Delete 
 
Deletes the selected contacts from the project 
 
Delete All 
 
Deletes all contacts from the project  
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4.12.1 Excel Import Contacts 
 
Contacts can be imported to the project from an Excel spreadsheet file using the following format: 
 

Column # Value 

1 First Name 

2 Last Name 

3 Phone 1 Country Code 

4 Phone 1 Phone Number (without country code ) 

5 Phone 2 Country Code 

4 Phone 2 Phone Number (without country code ) 

5 Email 1 

6 Email 2 

7 Title 

 
Table 3 – Contacts Excel File Format 

 
 
Sample of valid Excel spreadsheet file for contacts: 
 

 
 

Figure 46 – Contacts Excel File Sample 

 

 

 

 

  



 

49 
 

4.12.2 Adding New Contacts 
 
Click Add button on the Contacts tab to open Add New Contacts window: 

 

 
 

Figure 47 – Adding New Contacts 

 

Fill in only the required fields and click Add button to add contacts to the project. 

 

Only the First Name field is mandatory; other fields can be blank. 

 

To be able to send SMS messages, at least one phone number and the corresponding country code 

field should be filled in. 

 

Phone numbers can contain only digits and dashes. Phone numbers cannot have dashes at the 

beginning of the end. 

 

  

Country Code ( required ) 

 



 

50 
 

4.13 Logged Data 

Logged Data tab allows uploading log records from device to the computer, clearing log records, and 

exporting log records:  

 

 
 

Figure 48 – Logged Data Tab 
 

Note: The WiPOM Client has to be in ONLINE state to be able to read the logged data from the device. 

 

Read Data 

Read all logged records from the device 

 

Export Data 

Export read records to Excel or CSV (comma-separated value) file 
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Read Data 
 
Click the Read Data button to start reading log records from the device. While records are being read, 

the Reading Data window is shown: 

 

 
 

Figure 49 – Reading Data Window 
 

The Reading Data window shows the status of data reading operation: Number of reading records and 

date of last read record. 

 
All read records can be viewed under 3 different tabs: Tag Values, Alarms, and Events 
 
On each tab, the number of records in that tab is shown: 
 

 
 

Figure 50 – Number of records in tab titles 
 
  

Number of records 
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Export Data 
 
All read log records can be exported to an Excel or a CSV (comma delimited) file. 

Click the Export Data button to open the Export Data Window: 

 

 
  

Figure 51 – Export Data Window 
 
File Path  

Path to file to save log records 

 

Records 

These checkboxes allow saving only the desired type(s) of records. 

 

Format 

Output file format. 

Excel – Microsoft Excel file format 

CSV – Comma Separated Value text CSV file format. 

 

Fields 

These checkboxes allow selecting only the required fields for each record. 

 

Each record type on a separate sheet 

This option is available only in Excel file format. If this option is checked then Data, Alarm, and Event 

records are grouped in 3 separate Excel sheets in the same Excel workbook. If this option is unchecked, 

all records are put on the same Excel sheet. 

 

Colorize records 

This option is available only in Excel file format. If this option is checked, then Data, Alarm, and Event 

records have different background colors. This makes viewing easier when all the records are placed 

on the same Excel sheet. 



 

53 
 

4.14 Software Log 
 
The Software Log tab shows all the messages generated by the WiPOM Client. This is useful 

information for troubleshooting any problems:  

 

 
 

Figure 52 – Software Log tab 
 
 
In this window, Right-Click menu is available; this menu includes standard commands to copy text 

messages to Windows Clipboard: 

 

Select All 

This command selects all the messages in the list. 

 

Copy Selected   

This command copies selected message(s) to Windows Clipboard. 

 

Copy All 

This command copies all messages (selected or not selected) to Windows Clipboard. 

 

Clear Messages 

This command removes all messages from the list. 
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Appendix A: Sources of Firmware Reset 

 
Code Description 

UNKNOWN Unknown source of system restart 

POR Power on Reset 

EXTERNAL A low level on the Reset pin 

LOW PWR Low-power management reset 

WDT Independent watchdog timed out 

WIN WDT Windowed watchdog timed out 

SOFTWARE Software Reset 
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Appendix B: Error Codes 
 
General 
 
Internal errors ( not shown on LCD ). 

 
Code Description 

1 Invalid Argument. Some functions received wrong input data.  

2 The queue is empty when trying to read the next alarm/event from the queue 

3 The alarm/event queue is locked 

4 Timeout on wait operation 

 

Application Subsystem 
 

Code Description 

101 Starting the main task failed 

102 Starting cell modem task failed 

103 Starting RS485 server task failed 

104 Starting USB server task failed 

105 Starting UART0 server task failed 

106 Starting data logger task failed 

 

Configuration Subsystem 
 

Code Description 

201 No space for new tags  

202 Load device configuration failed 

203 Load tag’s configuration failed 

204 No space for a new contact record 

205 Invalid contact record ID 

206 Invalid contact record index 

207 Unsupported version of the contact record 

208 Load contact records failed 

209 Load message records failed 

210 No space for a new message record 

211 Invalid message record ID 

212 Invalid message record index 

213 Unsupported version of the message record 

214 Unsupported version of tag configuration 
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Core MODBUS Subsystem 
 

Code Description 

401 Unsupported register address 

402 Unknown function ID 

403 RTU is incorrect in reply 

404 Function ID is incorrect in reply 

405 CRC16 is incorrect in reply 

 

 
MODBUS RTU Subsystem 
 

Code Description 

501 Request data is not complete (broken) 

502 Too big request data (no space in internal buffer) 

503 Unknown function ID 

504 Bad CRC16 of MODBUS request/reply 

505 Processing MODBUS request failed 

 

MODBUS TCP Subsystem 
 

Code Description 

601 Request data is not complete (broken) 

602 Too big request data (no space in internal buffer) 

603 Unknown function ID 

604 Processing MODBUS request failed 

605 Unknown Protocol ID 

606 Length in MODBUS TCP header is incorrect 

 

RS485 Driver 
 

Code Description 

701 RS485 driver is not initialized 

702 Failed to clear RX buffer 

703 Failed to clear TX buffer 

704 Read Timeout 

705 Write Timeout 

706 No data to read 

707 Echo not received 
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Cell Modem Driver 
 

Code Description 

801 Cell Modem Driver is not initialized 

802 Failed to clear RX buffer 

803 Failed to clear TX buffer 

804 Read Timeout 

805 Write Timeout 

806 Read operation didn’t return any data 

807 No incoming TCP connection 

808 No reply for AT command 

809 Unknown reply for AT command 

810 Data to read is available 

 

 
Hardware Subsystem 
 

Code Description 

901 Hardware subsystem not initialized 

902 DAQ2543 / ADC self-test failed 

903 DAQ2543 / ADC not initialized 

904 Incorrect ADC channel number 

905 Incorrect DI pin number 

906 Incorrect DO pin number 

907 Write DO failed 

908 Read DI failed 

909 LCD Contrast adjustment failed 

910 LCD Backlight adjustment failed 

911 LCD initialization failed 

912 Incorrect LCD line number 

913 Configure Cell Modem input port failed 

914 DATAFLASH initialization failed 

915 SD card initialization failed 

916 No storage device detected (no SD card and no DATAFLASH) 

917 Incorrect frequency channel number 

918 Incorrect DAQ2543 channel number 
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Data Storage Subsystem 
 

Code Description 

1001 Unknown storage device ID 

1002 Storage device not initialized 

1003 Version structure has an incorrect signature byte 

1004 Version structure has incorrect version byte 

1005 Version structure has incorrect LRC byte 

1006 Data block has incorrect CRC16 

1007 No data available to read 

1008 Deep data check failed (read data is different from written data) 

1009 Read operation failed 

1010 Write operation failed 

1011 Find structure not initialized 

1012 Search action already started 

1013 Find the end of log records 

1014 The sector number is incorrect 

 

 
UART1 Driver 
 

Code Description 

1101 UART1 driver is not initialized 

1102 Failed to clear RX buffer 

1103 Failed to clear TX buffer 

1104 Read Timeout 

1105 Write Timeout 

1106 No data to read 

 

USB Driver 
 

Code Description 

1201 UART1 driver is not initialized 

1202 Failed to clear RX buffer 

1203 Failed to clear TX buffer 

1204 Read Timeout 

1205 Write Timeout 

1206 No data to read 

 

Communication Protocol 
 

Code Description 

1301 Unknown command received 
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Appendix C: Internal MODBUS Registers 
 
Digital Inputs 
 

Code Description 

10001 Digital Input #1 

10002 Digital Input #2 

10003 Digital Input #3 

10004 Digital Input #4 

 

Digital Inputs (Frequency Counter) 
 

Code Description 

40113 Digital Input #1 

40114 Digital Input #2 

 
Digital Inputs (Pulses Counter) 
 

Code Description 

40122 Digital Input #1 (High 2 bytes of LONG value) 

40123 Digital Input #1 (Low 2 bytes of LONG value) 

40124 Digital Input #2 (High 2 bytes of LONG value) 

40125 Digital Input #2 (Low 2 bytes of LONG value) 

40126 Digital Input #3 (High 2 bytes of LONG value) 

40127 Digital Input #3 (Low 2 bytes of LONG value) 

40128 Digital Input #4 (High 2 bytes of LONG value) 

40129 Digital Input #4 (Low 2 bytes of LONG value) 

 
NOTE: Bytes placed in the following order: 
 

High byte Low byte High byte Low byte 

High register Low register 

UNSIGNED LONG value (4 bytes) 

 
 
 
 
 
For example, read values for DI #1 in Pulses Counter mode 
Register #40122 returns 0xA102 
Register #40123 returns 0x0C15 
The result unsigned long value will be 0xA1020C15 
 

  

High bytes Low bytes 
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Digital Outputs 
 

Code Description 

1 Digital Output #1 

2 Digital Output #2 

  

Analog Inputs 
 

Code Description 

30001 Analog Input #1 (AN2) 

30002 Analog Input #2 (AN3) 

30003 Analog Input #3 (PC3) 

30004 Analog Input #4 (Battery voltage) 

30005 Analog Input #5 (5V) 

 

Analog Inputs (RMS mode) 
 

Code Description 

30006 Analog Input #1 (AN2) 

30007 Analog Input #2 (AN3) 

 

DAQ-2543 Inputs 
 

Code Description 

30008 Channel #0 

30009 Channel #1 

30010 Channel #2 

30011 Channel #3 

30012 Channel #4 

30013 Channel #5 

30014 Channel #6 

30015 Channel #7 

30016 Channel #8 

30017 Channel #9 

30018 Channel #10 
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Holding Registers 
 

Code Description 

40001 Hardware Id. 0 – nanoWiPOM, 1 – WiPOM, -1 – unknown device 

40100 RTU number 

40101 RTC - Year 

40102 RTC - Month 

40103 RTC - Day 

40104 RTC - Hour 

40105 RTC - Minutes 

40106 RTC - Seconds 

40107 

RESET Reason: 
1 - POR (Power-On-Reset) 
2 - External Pin Reset 
3 - Low Power Reset 
4 - Watchdog Reset 
5 - Window Watchdog Reset 
6 - Software Reset 

40108 Last System Error Code (See Appendix B for list of possible errors) 

40109 Uptime in seconds (low word) 

40110 Uptime in seconds (high word) 

40111 Hardware Status. Please see Note C.1 below. 

40112 Firmware Version. Please see Note C.2 below. 

40115 Total MODBUS Errors (counter reset on system start) 

40116 Total MODBUS Exceptions (counter reset on system start) 

40117 Total DATAFLASH Write Errors (counter reset on system start) 

40118 Total DATAFLASH Read Errors (counter reset on system start) 

40119 Total SD card Write Errors (counter reset on system start) 

40120 Total SD card Read Errors (counter reset on system start) 

40121 

Cell Modem Type 
0 – Unknown 
1 – WMP50 (2G) 
2 – HE910D (3G) 
3 – CloudGate (nanoWiPOM used as a peripheral board on CloudGate 
device)  

 
 
 
 

  

Read-only Registers 
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Hardware Status 
 

Bit # Description 

0 Core system initialized 

1 UART0 driver initialized 

2 UART1 driver initialized 

3 UART2 driver initialized 

4 UART3 driver initialized 

5 USB driver initialized 

6 IO driver initialized 

7 ADC driver initialized 

8 UART0 service initialized 

9 RS485 service initialized 

10 Cell modem service initialized 

11 USB service initialized 

12 Display driver initialized 

13 DAQ2543 driver initialized 

14 Cell modem detected 

 
 
If bit set to 0 – it means that device/driver/subsystem was not initialized (some issues detected) 
If bit set to 1 – it means that device/driver/subsystem was initialized 
 
 

Firmware Version 
 
The firmware version is encoded as an integer value. 
It contains 2 parts: Major version number and minor version number. 
 
To get the correct version it should be processed as: 
 
Major = VALUE / 100 
Minor = VALUE % 100 
 
/  - integer divide  
%  - modulus 
 
For example, if register returns value 211 (decimal), this means: 
 
Major = 211 / 100 = 2 
Minor = 211 % 100 = 11 
 
Version = 2.11 
 
 


